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Preface 

Who should read this guide 
This guide is written for Elluminate Live!® and Elluminate Publish! ™ users of all levels of 
expertise. 

Updates to this guide 
Occasionally, updates are made to this guide. For the latest version, see the Elluminate 
Publish! webpage at http://www.elluminate.com/publish/info.jsp.  

Conventions used in this guide 

Operating system differences 
This guide is written for Elluminate Publish! users on Windows, Linux and Mac platforms 
and gives instructions for all supported operating systems.  

Screen captures 

Most of the screen captures shown in this guide were taken in a Windows environment. If 
you are running Elluminate Publish! on a Mac or Linux, the appearance of windows, dialog 
boxes, etc. will differ slightly from those shown in this guide. 

Notes 
Three types of notes are used in this guide to highlight information:  

 Notes of this format are used to highlight important information or to 
present asides relevant to the topic at hand. 

 This is a tip. Tips provide helpful information on how to most 
effectively use a particular function in Elluminate Publish!  

 This is a caution. Cautions alert you to potentially confusing 
terminology or difficulties that may occur when using Elluminate Publish! 

http://www.elluminate.com/publish/info.jsp
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Typographical conventions 

Convention  Description 

1. Number  Used to indicate a step in a task. 

 Checkmark Used for listing the different options available to 
you to complete a task or function. Pick one only. 

Bold Used to give emphasis to a word. 

Italics Used to represent options or parameters. Also used 
in cross references to sections in this guide or other 
guides. 

Underline Used for links, such as links to websites. 

Monospace Used to indicate pathnames, filenames and folders.  

End User Elluminate Technical Support  
Elluminate technical support for end users is available through the following channels: 

Support Website http://www.elluminate.com/support  

Support Portal http://support.elluminate.com  
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Chapter 1  Introduction 

Product Overview 
When you record an Elluminate Live! session, the recording is stored in a VCR1 file that can be 
played back on your computer. Playing VCR files requires a network connection to access the 
necessary Elluminate Live! software.  

 When a session is recorded, only the activity in the main room is 
recorded (except for private chat messages).  

Using Elluminate Publish!™, you can make the most of your Elluminate Live!® recordings by 
publishing them to a variety of formats that can be played independently of a network 
connection, giving you freedom to play Elluminate Live! recordings wherever you like. 

To play the audio of an Elluminate Live! recording while away from your computer, convert 
them to audio podcasts and listen to them on your iPod or other MP3 player. To play full 
Elluminate Live! recorded sessions while not connected to the Internet, create Elluminate 
Unplugged!™ standalone recordings and play them on your desktop computer or laptop or 
create multimedia (movie) files to play on your portable movie player or player application on 
your computer. 

You also can produce transcripts of your Chat and Closed-Captioning text in RTF format for 
reading or editing, or in SRT format for creating subtitles for your movies. 

Input Types 
The following files can be used by Elluminate Publish! to generate output files. For details on 
accessing these files, refer to Accessing Recordings on page 18.  

 Not all output file types can be generated from all input file types. For 
details, see Table 1: Output Files on page 2. 

 VCR (.vcr) – A VCR (Virtual Conference Recording) file is the actual recording file 
generated by Elluminate Live! when a session is recorded.  

 JNLP (.jnlp) – A JNLP (Java Network Launching Protocol) file contains the URL to a 
VCR file as well as the information required to launch the Elluminate Live! player for that 
recording. 

 MRF (.mrf) – This is a Media Recording File. For details, see Media Recording Files on 
page 5. 

 URL – This is a link that can be resolved to a valid file type: VCR, JNLP or MRF. 
                                                 
1 Virtual Conference Recording 
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Output Files 
The following table describes what output files can be created in Publish! from which input 
files and what content from the original recording is included in the output files.  

Table 1: Output Files

Elluminate 
Live! 
recordings 
supported 

Input file types 
supported 

Content included in 
output 

Output file types 

Multimedia (movie) 
Audio, Application 
Sharing & Whiteboard 
activity only 

AVI, FLV, H.264, 
MOV, MP4 & WMV 

Closed Captioning 
activity only 

.MovieCaption.rtf 

.MovieCaption.srt 

V8 to V9.5 VCR, JNLP, 
Unplugged!, URL 
& MRF  

Chat activity only .MovieChat.rtf  

Audio 
V6.5 to V9.5 VCR, JNLP, 

Unplugged!, URL 
& MRF 

Audio activity only MP3, M4A, Ogg 
Vorbis, uncompressed 
WAV file 

Unplugged! recording 
V6.5 to V9.5 VCR, JNLP, 

Unplugged! & 
URL 

All Elluminate Live! 
activity 

.jar 

Captioning Transcript 
V6.5 to V9.5 VCR, JNLP, 

Unplugged! & 
URL 

Closed Captioning 
activity only 

.VCRCaption.rtf  

Chat Transcript 
V6.5 to V9.5 VCR, JNLP, 

Unplugged! & 
URL 

Chat activity only .VCRChat.rtf  
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Multimedia (Movie) Files 
With Publish!, you can convert Elluminate Live! V8 to V9.5 recordings (.vcr and .jnlp files and 
URLs) or MRF2 files to any of the following multimedia file formats: 

 AVI (Audio Video Interleave) 

 FLV (Flash video) 

 H.264 (MPEG-4 video with H.264 compression)  

 MOV (QuickTime video) 

 MP4 (MPEG-4 video) 

 WMV (Windows Media Video) 

 MRF (Media Recording File) 

While creating your multimedia file, you also can create transcript files from the recording’s 
Chat and Closed Captioning streams.3 One type of Closed Captioning transcript (the SRT file) 
is suitable for generating subtitles to be merged with the generated movie.  

 Because the subtitles in the SRT file are created exactly as seen within 
the session, there may be times that the subtitles overlap each other and 
become difficult to read. You may want to edit the display start and end times 
for the subtitles in SRT file to ensure that the times do not overlap. (For 
informaiton on editors, see 3rd Party Resources for Movie and Subtitle Editing 
on page 39.) 

If the session creator enabled the Hide Attendee Names option for recordings, Moderator and 
Participant names will not be displayed in the transcript files but will be replaced by the generic 
names Participant 1, Participant 2, etc. 

 When a multimedia file is created, only the Audio, Application Sharing 
and Whiteboard tracks are included in the output file. If Application Sharing 
and Whiteboard activity is occurring at the same time within a recording, the 
Application Sharing will take precedence over the Whiteboard during the 
creation of the multimedia file since both cannot be presented at the same time.  

                                                 
2 Media Recording File (see Media Recording Files on page 5) 
3 The multimedia conversion utility strips areas of inactivity from the original recording, preventing the 
converted recording from having long periods of idleness. The transcripts will be synchronized with the 
altered timeline. 
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Audio Files  
Publish! enables you to convert Elluminate Live! V6.5 to V9.5 recordings (.vcr4 and .jnlp5 files 
and URLs) or MRF files to any of the following audio file formats: 

 MP3 (MPEG-3 audio – 32 or 64 kbps) 

 M4A (MPEG-4 audio)  

 Ogg Vorbis (open-source format) 

 uncompressed WAV files (Waveform, uncompressed audio) 

Unplugged! Recordings 
With Publish!, you can convert an Elluminate Live! V6.5 to V9.5 recording to a standalone 
version (a .jar file) that can be viewed from your desktop or laptop without being connected to 
an Elluminate server or the Internet.  

 An Unplugged! Recording cannot be generated from an MRF file. 

Closed Captioning and Chat Transcripts 
Finally, Publish! enables you to convert the Chat and Closed Captioning streams of your 
Elluminate Live! V6.5 to V9.5 recordings (.vcr6 and .jnlp7 files and URLs) in the same time 
line as the original recording.  

 Chat and Closed Captioning Transcripts (those not associated with 
Multimedia files) cannot be generated from an MRF file.  

If the session creator enabled the Hide Attendee Names option for recordings, Moderator and 
Participant names will not be displayed in the transcript files but will be replaced by the generic 
names Participant 1, Participant 2, etc. 

Closed Captioning transcripts include all the entries from all captioners together in a single file. 
The transcripts include the captioner’s name (except as noted above), the time of the caption 
and the text of the caption. If there are multiple captioners, the caption information is 
aggregated into blocks, by captioner. 

                                                 
4 Virtual Conference Recording 
5 Java Network Launching Protocol 
6 Virtual Conference Recording 
7 Java Network Launching Protocol 
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Why are there two Chat and two Closed Captioning transcripts and when would I 
use either one? 

Chat or Closed Captioning transcripts that are created independently (not associated with a 
multimedia file) are named VCRChat and VCRCaption. When playing a VCR recording or an 
Unplugged! recording, periods of inactivity greater than 5 seconds are skipped; however, the 
time stamps displayed on the time slider of the recording will correspond to the times the 
various activities actually took place in the original session. To match this, the VCRCaption 
and VCRChat files will use the times in the original session for their entries.  

Movie production eliminates even more “dead-air” from the time line, changing the time 
correspondence between the VCR recordings and transcripts and the movie playback. Publish! 
produces MovieChat and MovieCaption transcripts that hold the same data as the VCRChat and 
VCRCaption transcripts but use the time line of the movie, where the time in the transcript 
corresponds to the slider of the movie player. This retains the ability to use the transcripts as a 
guide to the movie.  

Media Recording Files 
When you create a movie file, an intermediate Media Recording File (MRF) is created 
automatically. This file is generated during the initial VCR analysis phase of the multimedia 
conversion process. This process takes place in real time and may be quite time consuming 
(e.g., it will take around one hour to analyze a one hour recording).  

You may instruct Elluminate Publish! to produce an MRF file alone (select MRF Only from the 
Format drop-down list).  

 To save time when producing multiple output files types from a single 
recording, you can use an existing MRF file to create additional multimedia 
output files, thereby skipping the initial VCR analysis phase for each 
subsequent output production.  
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System Requirements 

Operating system 
Elluminate Publish! can be installed on Windows, Linux and Mac OS platforms:  

 Windows XP or Vista 

 Novell SUSE 10 Linux and Red Hat Linux (RHEL5) 

 Mac OS X 10.4 or 10.5 

Java 
In order to run Elluminate Publish! and play Unplugged! recordings, you must have Java 
Runtime Environment (JRE) version 1.5 or higher running on your system. You can download 
the current Java Runtime Environment for your system from Sun’s Java website:  

http://www.java.com/en/download/manual.jsp 8

                                                 
8 Note that Java version 6 on the download page is equivalent to JRE 1.6. 
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Chapter 2  Installing and Uninstalling 
Elluminate Publish!  

Installing Elluminate Publish!  
The installer for Elluminate Publish! can be downloaded from the Elluminate Publish! website 
(http://www.elluminate.com/publish/info.jsp).  

 Version 2.1 of Elluminate Publish! may be installed over version 2.0 or 
version 1.0. There is no need to uninstall the earlier version first. 

To install Elluminate Publish!, follow the steps below: 

 Each step below discusses a panel in the installer. Move between the 
panels by clicking the Next > button. 

1. Click on the installer icon. The Welcome panel appears. (You don’t need to do 
anything here, so continue to the next panel.) 

 

http://www.elluminate.com/publish/info.jsp
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2. Read the license agreement and select I accept the agreement.  

 

 If you do not accept the agreement, you will not be able to continue with 
the installation.  

3. Specify the directory in which you would like to install Elluminate Publish! Either 
accept the default directory or browse to and select a different directory.  
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 To install over an existing version on Windows (that was installed in the 
default location), select C:\Program Files\Elluminate. To install over an 
existing version on Mac OS X (that was installed in the default location), select 
/Applications/Elluminate. 

 This panel lists the disk space required for Elluminate Publish! Make 
sure you specify a directory on a drive that has sufficient disk space.  

The default locations are as follows: 

Windows 
C:\Program Files\Elluminate\Elluminate Publish 

Mac 
/Applications/Elluminate/Elluminate Publish  

Linux 

Root Login:  
/opt/Elluminate/Elluminate_Publish 

Standard Login:  
/home/<user_name>/Elluminate/Elluminate_Publish 

4. (Linux only) Specify the directory into which you would like to install the symlinks.  

 

 Root users can use the default location (/usr/local/bin). However, 
standard users typically do not have write access to this location and will have 
to choose a different directory.  
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5. (Windows users only.) Specify into which Start Menu folder you would like the 
program shortcut for Elluminate Publish! to be placed.  

 
Select the name of a Start Menu folder by doing one of the following: 

 Accept the default name selected (Elluminate). 

 Enter a new folder name. 

 Select a folder from the list provided. 

A subfolder, called Elluminate Publish!, will be added under the folder you specify so, 
if you used the default, the shortcut’s path will be Start > Programs > Elluminate > 
Elluminate Publish! > Elluminate Publish! 

6. Specify whether or not you would like the installer to create an Elluminate Publish! 
icon on your desktop and (for Windows only) a Quick Launch icon in your taskbar.  
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7. Read the summary information and, if you are satisfied that you are installing Publish! 
in the correct location and with the appropriate settings, click Next > to start the 
installation process. (Otherwise, click Cancel to quit the installation process or < Back 
to change your settings.)  

 
The Installing panel will appear, showing the progress of your installation. 
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8. When installation is complete, the following panel is displayed. Select the option Run 
Elluminate Publish! if you would like to start the application immediately.  

 

9. Click Finish to exit the setup. 

 You can have Elluminate Publish! check for software updates 
automatically each time it is launched. For details, see General Preferences on 
page 35. 

Uninstalling Elluminate Publish!  

Windows 
On Windows, use the uninstall application to remove Elluminate Publish! from your computer. 
The uninstaller performs four tasks: 

 Removes the application icon from your desktop. 

 Removes the Quick Launch icon in your taskbar. 

 Deletes the application folder and its contents:  
C:\Program Files\Elluminate\Elluminate Publish 

 Removes the Elluminate Publish! Start Menu items.  

 The Elluminate folder that was created during the installation process will 
not be deleted as other Elluminate applications may have been added to it since you 
initially installed Elluminate Publish!  
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To uninstall Elluminate Publish!, launch the uninstaller in one of two ways:9  

 Select Start > Programs > Elluminate > Elluminate Publish! >Elluminate Publish! 
Uninstaller; or 

 Run the Elluminate Publish! executable file (uninstall.exe):  
C:\Program Files\Elluminate\Elluminate Publish\uninstall.exe 

Mac 
On the Mac, the uninstaller performs two tasks: 

 Removes the application icon from your desktop. 

 Deletes the application folder and its contents:  
/Applications/Elluminate/Elluminate Publish 

To uninstall Elluminate Publish!, run the Elluminate Publish! uninstaller executable file:  
/Applications/Elluminate/Elluminate Publish/Elluminate 
  Publish! Uninstaller 

If you created a desktop icon during installation, delete that as well. 

Linux 
On Linux, the uninstaller performs three tasks: 

 Removes the application icon from your desktop. 

 Deletes the application folder and its contents:  

Root Login: /opt/Elluminate/Elluminate_Publish 

Standard Login: /home/<user_name>/Elluminate/Elluminate_Publish 

 Removes the symlinks. 

To uninstall Elluminate Publish!, run the Elluminate Publish! uninstaller executable file:  

Root Login:  
/opt/Elluminate/Elluminate_Publish/uninstall 

Standard Login:  
/home/<user_name>/Elluminate/Elluminate_Publish/uninstall 

                                                 
9 If you installed in a location other than the default, use the path you specified in step 3 on page 8.  



Installation and User’s Guide – Registering Elluminate Publish! 

Chapter 3  Registering Elluminate Publish!  

Entering your license key and registration information 
when you start 
The first time you launch Elluminate Publish! you will be prompted to enter your license key 
and registration information. If you do not have a license key, contact your Elluminate system 
administrator who can provide it to you.10

 Registration is mandatory. You will not be able to use Elluminate 
Publish! until you complete the registration process. Each time you activate a 
new license key you will be asked to register again. 

You may update your registration information from within Elluminate Publish! 
by selecting Registration from the Help menu. 

1. Launch Elluminate Publish! in one of the following ways: 

 Click on the Elluminate Publish! icon on your desktop.  

 (Windows only) Click on the Quick Launch icon in your taskbar. 

 (Windows only) Navigate to and select the Start Menu shortcut. If you chose the 
default for your shortcut, select Start > Programs > Elluminate > Elluminate Publish! 
> Elluminate Publish! 

 Run the Elluminate Publish! executable file:  

Windows 
C:\Program Files\Elluminate\Elluminate Publish\Publish.exe 

Mac 
Applications/Elluminate/Elluminate Publish/Elluminate Publish 

Linux 

Root Login:  
/opt/Elluminate/Elluminate_Publish/Elluminate Publish! 

Standard Login: 
/home/<user_name>/Elluminate/Elluminate_Publish/ 
 Elluminate Publish! 

The License Key panel appears.  

                                                 
10 When Elluminate Publish! is purchased, Elluminate sends a license key file to your organization via 
email. 
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2. Select and activate your license key file in one of the following ways: 

 Browse to the file and click on Activate.  

 Drag and drop the file into the License window and click on Activate. 

 
The registration form opens.  
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3. (Optional) If you are behind a firewall and your browser requires a proxy to make a 
connection, you will need to define a proxy for Publish!   

a. Click on the Proxy Settings button to open the Proxy Settings tab of the 
Preferences dialog. 

b. Select Manual Proxy Settings and fill in the host names and ports with the 
information found in your browser. (For details, see Proxy Setting Preferences on 
page 35.) 

4. Complete the registration form. 

a. Enter information about yourself and your organization. 

 All fields marked with an asterisk (*) are mandatory: First Name, 
Last Name, Email Address, City, State/Province/County/Region and 
Country.  

 The Country field may be filled in automatically based on 
information obtained from your computer’s system configuration.  

 If the Country field is not automatically filled in, you will need to 
manually select it before you can select State/Province/Region.

b. Select the desired options: 

 Technical information and updates: if you select this option, you will be placed 
on Elluminate’s technical mailing list and receive information such as tips on 
using Elluminate Publish! (and Elluminate’s other products) and information on 
the availability of Elluminate Publish! upgrades. 

 Other information and offers: if you select this option, you will be placed on an 
Elluminate mailing list and receive Elluminate’s semi-monthly newsletter 
Newsline, as well as occasional email promotions. 

c. Click on Register. This will open the registration confirmation panel that displays 
your registration information. 
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5. Confirm your registration information.   

 

6. Click on the link Display the Elluminate Privacy Policy in the default browser to read 
the Privacy Policy. 

7. Select the option I have read and accept the Elluminate Privacy Policy and click on 
Confirm. 

 To complete registration, you must select this option. If you do not, the 
Confirm button will be disabled.  

The Elluminate Publish! application is launched. 

Entering your registration information from within the 
application 
You can update your registration information from within the application.  

From the Help menu, select Registration and then follow the steps outlined in Entering your 
license key and registration information when you start on page 14 (beginning with step 4). 
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Chapter 4  Accessing Recordings 
You need to supply Elluminate Publish! with a VCR file, a JNLP file or a URL of the recording 
or MRF you wish to convert.11 This section discusses how to gain access to .jnlp files and 
URLs for use in Elluminate Publish! It does not discuss obtaining .vcr files.  

 Elluminate Publish! users typically will not have direct access to .vcr 
files and must request them from their Elluminate Live! administrator.  

Elluminate Publish! currently does not directly support Elluminate Live! Manager recording 
links. The best way to access an Elluminate Live! Manager recording is by launching Publish! 
through your browser (as described below).  

Alternatively, you can save the JNLP (see Saving JNLPs to Your Computer on page 22). 

A Note on Secure Recordings 

Security controls set in the session scheduling server (Session Administration System or 
Elluminate Live! Manager) may prevent you from launching a recording. (You will receive an 
error message indicating that you don’t have the required access.) You may be able to get 
around this by opening the .jnlp file directly in Elluminate Publish!  For details, see Opening 
JNLP Files Directly in Elluminate Publish! on page 18. 

Consult your Elluminate Live! administrator to discuss access to secured recordings.  

Opening JNLP Files Directly in Elluminate Publish!  

On Windows, Mac or Linux Using Firefox 3 
When using Firefox12 in Windows, Mac or Linux, you can open the .jnlp file directly in 
Publish! for immediate conversion.  

1. Launch Firefox. 

2. (Windows) From the Tools menu select Options and then select the Applications tab.  
(Linux) From the Edit menu select Preferences and then select the Applications tab. 

3. In the column Content Type, find “JNLP File”, select “Always ask” in the Action 
column and click on OK. 

                                                 
11 MRF files can also be used if the recording has previously been converted to a movie. For details, see 
Media Recording Files on page 5. 
12 You can use any browser that allows you to specify what application to use to open recording links. 
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4. Launch the recording in Firefox. 

 If the recording is from the Session Administration System (SAS), and 
the recording owner has selected the option Enable Recording Viewer Details, 
you will be prompted to fill in a form with your email address and name before 
you can proceed to the next step. 

5. Open the .jnlp file in Elluminate Publish! If Elluminate Publish! is not in the list of 
available applications, select Other… and browse to the application. (The application 
will be in the directory you specified in step 3 of Installing Elluminate Publish! on 
page 8.)  

 

6. If the option Do this automatically for files like this from now on is selected (checked), 
de-select (uncheck) it. 

 If you fail to do this, you will not be able to enter an Elluminate Live! session 
– Windows or Linux will attempt to open the session in Elluminate Publish! 

7. Click on OK. Elluminate Publish! will open and the pathname of your .jnlp file will be 
entered into the Recording field, ready for conversion. 
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On Windows Using Internet Explorer 6  
When using Internet Explorer 6, you can open the .jnlp file directly in Publish! for immediate 
conversion.  

 You cannot use Internet Explorer 7 or 8 to open JNLPs directly in 
Elluminate Publish! Use either Internet Explorer 6 or Firefox 3 or, 
alternatively, save the JNLP file (see Saving JNLPs to Your Computer on 
page 22). 

 If you follow the procedure below, recordings launched in Internet 
Explorer will always open in Elluminate Publish! – until you reverse the 
settings. Using Firefox as your browser will give you the option of launching 
(playing) the recordings or opening them in Elluminate Publish!  

1. Open Windows Explorer (not Internet Explorer). 

2. From the Tools menu, select Folder Options.  

3. Click on the File Types tab and select the JNLP File type, as depicted below: 

 

4. Under Details for ‘JNLP’ extension, click on the Change button for the Opens with 
option. 
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5. Select Elluminate Publish! from the list of programs. If it is not in the list, browse to 
the application. (The application will be in the directory you specified in step 3 of 
Installing Elluminate Publish! on page 8.) 

 

6. De-select (uncheck) the option Always use the selected program to open this kind of 
file and click on OK. 

 If you fail to do this, you will not be able to enter an Elluminate Live! 
session – Windows will attempt to open the session in Elluminate Publish! 

7. Launch the recording in Windows Explorer. 

 If the recording is from the Session Administration System (SAS), and 
the recording owner has selected the option Enable Recording Viewer Details, 
you will be prompted to fill in a form with your email address and name before 
you can proceed to the next step. 
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8. In the File Download dialog, click on the Open button.  

 
Elluminate Publish! will open and the pathname of your .jnlp file will be entered into 
the Recording field, ready for conversion. 

 

Saving JNLPs to Your Computer 
A simple way to access a recording for conversion in Elluminate Publish! is to save a .jnlp file 
of the recording. To do so, you need to launch the recording. 

On Windows or Linux Using Firefox 3 
On Windows or Linux you can intercept the Firefox download to save the .jnlp file. 

1. Launch Firefox. 

2. (Windows) From the Tools menu select Options and then select the Applications tab.  
(Linux) From the Edit menu select Preferences and then select the Applications tab. 

3. In the column Content Type, find “JNLP File” and select “Always ask” in the Action 
column. 
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4. Launch the desired recording.  

 If the recording is from the Session Administration System (SAS), and 
the recording owner has selected the option Enable Recording Viewer Details, 
you will be prompted to fill in a form with your email address and name before 
you can proceed to the next step. 

5. You will be prompted to Open or Save the JNLP file. Save the .jnlp file to a convenient 
location on your computer. 

 

On Windows Using Internet Explorer 6 or 7  
On Windows, you can save a .jnlp file of your recording to your computer by launching the 
recording and then intercepting the Internet Explorer download and saving the .jnlp file. 

 You cannot use Internet Explorer 8 to intercept .jnlp files. Use either 
Internet Explorer 6 or Firefox 3. 

 On Vista, you cannot intercept the .jnlp file using Internet Explorer 7. 
Use IE 6 or Firefox 3 instead or use a .vcr file rather than a JNLP file. 

 The following instructions explain how to do this with Windows XP.  

1. Open Windows Explorer (not Internet Explorer). 

2. Select Folder Options… from the Tools menu.  
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3. Click on the File Types tab and select the JNLP File type, as depicted below: 

 

4. Click on the Advanced button and then select Confirm open after download, as shown 
below. 
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5. Launch the desired recording.  

 If the recording is from the Session Administration System (SAS), and 
the recording owner has selected the option Enable Recording Viewer Details, 
you will be prompted to fill in a form with your email address and name before 
you can proceed to the next step. 

6. You will be prompted to Open or Save the JNLP file. Save the .jnlp file to a convenient 
location on your computer.  

 

On the Mac 
Follow the steps below to download the .jnlp file to your Mac: 

1. Find the download location on your Mac by looking at the download settings in your 
preferred browser.  

 Use any version of Firefox or any version of Safari earlier than v.3. 

2. Launch the desired recording.  

 If the recording is from the Session Administration System (SAS), and 
the recording owner has selected the option Enable Recording Viewer Details, 
you will be prompted to fill in a form with your email address and name before 
you can proceed to the next step. 

The .jnlp file of your recording will be automatically downloaded to the default 
download location (as specified by your browser). 



Installation and User’s Guide – Accessing Recordings 

Accessing URLs from the Session Administration 
System (SAS) 
The best way to enter a recording URL into Elluminate Publish! is to launch Elluminate 
Publish! through your browser (for details see A Note on Secure Recordings 

 on page 18). Refer to Opening JNLP Files Directly in Elluminate Publish! on page 18 for 
instructions.  

Alternatively, you can copy the URL from another source and paste it into Elluminate Publish! 
Hosted customers using the SAS can access recording URLs in the following ways:  

 Get the URL from the session creator or an SAS administrator.  

 Get the URL from an email that may be sent to you (and all session attendees) after the 
recorded session is complete. (Session creators can set this option when creating the 
session.)  

 Log in to the SAS and retrieve the URL of the recording by checking the session details. 
(Recordings list within the SAS File utility). For instructions, see our Retrieving 
Recording Links in the SAS Quick Reference Guide:  
http://www.elluminate.com/support/docs/sas/Retrieving_Recording_Links_in_SAS.pdf 
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Chapter 5  Using Elluminate Publish!  
The Elluminate Publish! interface consists of three main functional areas: the top area in which 
you identify the input file to be converted, the middle area in which you specify what types of 
conversions you would like to do (outputs), including conversion settings, and the bottom area 
that provides you information on the status of your conversion.  

 

Launching Elluminate Publish!  
To launch Elluminate Publish!, do one of the following: 

 Launch Elluminate Publish! through your browser. (For details, see Opening JNLP Files 
Directly in Elluminate Publish! on page 18.) 

 Click on the Elluminate Publish! icon on your desktop.  

 (Windows only) Click on the Quick Launch icon in your taskbar. 
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 (Windows only) Navigate to and select the Start Menu shortcut. If you chose the default 
for your shortcut, select Start > Programs > Elluminate > Elluminate Publish! > 
Elluminate Publish!  

 Run the Elluminate Publish! executable file:  

Windows 
C:\Program Files\Elluminate\Elluminate Publish\Publish.exe 

Mac 
Applications/Elluminate/Elluminate Publish/Elluminate Publish  

Linux 

Root Login:  
/opt/Elluminate/Elluminate_Publish/Elluminate Publish!  

Standard Login: 
/home/<user_name>/Elluminate/Elluminate_Publish/ 
  Elluminate Publish! 

The Elluminate Publish! window will open:  
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Automatic Check for Updates 
Elluminate Publish!, by default, will automatically check for software updates when you launch 
the application. If a new version of the software is available, you will be notified of the update.  

 
When presented with the New Update Available dialog, you have three options: 

 Click on Go to Web Site: this will take you to the Elluminate Publish! product download 
web page (http://www.elluminate.com/publish/info.jsp) where you can download the latest 
version of Elluminate Publish! for your specific platform. 

 See Installing Elluminate Publish! on page 7 for instructions on installing 
Elluminate Publish!  

 Click on Remind Later: this will skip the update for now and will cause this update 
notification to be displayed again next time you launch Elluminate Publish!  

 Click on Ignore Update: this will prevent Elluminate Publish! from checking for updates 
for this particular version next time you launch the application. For example, if you have 
version 2.0 and click on Ignore Update when notified that version 2.1 is available, you 
will not be reminded again to update to version 2.1. However, when version 2.2 becomes 
available, you will be notified since Ignore Update is ignoring version 2.1 only.  

 If you accidentally clicked on Ignore Update, you can always manually 
check for updates by selecting Help > Check for Update. If there is an update 
available, you can go to the website to download it or click on Remind Later 
to be reminded next time you launch Elluminate Publish!  

If you prefer not to be notified of software updates, you can turn off the option Check for 
updates automatically at launch in the Preferences dialog. (For details, see Setting Publish! 
Preferences on page 35.)   

 We recommend that you leave the option Check for updates 
automatically at launch selected – then you will always know when a software 
update is available. 

http://www.elluminate.com/publish/info.jsp
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Publishing Output Files 
To convert your recordings, follow the steps below: 

1. If desired, enter the intellectual property metadata you would like embedded in your 
output files. For details, see Intellectual Property Preferences on page 35. 

 If you do not enter the metadata before you publish the recording, you 
will not have an opportunity to do it later. 

 Not all file formats can accept all metadata items. 

2. Identify the file you would like to convert by entering it into the Recording field. (This 
step is unnecessary if you launched Elluminate Publish! through your browser – the 
field will already be filled in.) If the recording is a .vcr, .mrf or .jnlp file, enter the full 
pathname of the file. To avoid typing errors, drag and drop or browse to the file 
instead. 

 Since you cannot browse to a recording URL, to avoid typing errors, 
copy the link from another source (your browser or an email) and paste it into 
the field.13 (See Accessing URLs from the Session Administration System on 
page 25.)  

At this point, Publish! reads the VCR to extract the session name, which will be used 
for the file names of the output files.14 This process will typically copy the VCR file to 
your local system, which may take some time for large recordings. 

When the recording is locally available, Publish! will show you the session name.

 An .mrf file cannot be used to generate an Unplugged! Recording or 
(non-multimedia) Chat and Captioning transcripts. 

                                                 
13 Use the Paste keyboard shortcut Ctrl+V (⌘V on Macintosh). You cannot access the Paste command 
from a menu by right-clicking in the field. 
14 Except for version 6.5 and 7 recordings, which do not know the session name. 
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3. Indicate what types of conversions you wish to perform and specify conversion 
settings. You may convert to any or all available formats. 

 To create a multimedia (movie) file, click on the Create Multimedia Files option. (For 
details about setting multimedia file options, see Multimedia Output File Options on 
page 32.) 

 The multimedia conversion utility strips areas of inactivity from the 
original recording, preventing the converted recording from having long 
periods of idleness. Therefore, your converted multimedia file may be shorter 
than the original recording.  

 To create an audio podcast, click on the Create Audio File option. (For details about 
setting audio file options, see Audio File Options on page 34.) 

 If your recording does not have any audio created as a result of 
pressing the Talk button, an audio podcast can not be created – even if 
there was sound being generated in your recording by a multimedia file. If 
you don’t know whether or not there is any “Talk” audio in your recording, 
go ahead and try to convert it. If there was no “Talk” audio, you will 
receive a message telling you that the recording has no audio and no audio 
file will be generated.  

 The size of your converted audio file may be larger or smaller than 
the original recording, depending on the extent of the audio and non-audio 
content in the recording.  

 To create an Unplugged! recording, click on the Create Unplugged Recording 
checkbox.  

 Because an Unplugged! recording contains all the Elluminate Live! 
software required to play a recording, the Unplugged! recording will be 
approximately 10 MB larger than your original recording.  

 To create a VCR Caption Transcript, click on the Create Caption Transcript option.  

 To create a VCR Chat Transcript, click on the Create Chat Transcript option.  

4. Click on the Convert button to begin the conversion (or Cancel to abandon the 
operation). The Convert dialog box will open. 

5. From the Convert dialog box, select the directory in which you wish to save your 
output files (including the MRF file) and indicate the file name you wish to use for 
your output files. (All the files will have the same name with different suffixes.)  
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6. Click on Convert to begin the conversion process. If you are not using an MRF as an 
input for Multimedia conversion, and Elluminate Publish! has detected an MRF with 
the correct session name in the output folder, you will be asked if you wish to use it 
instead to create the Multimedia output. This will shorten the conversion process 
considerably as the “convert to MRF” step will not be required. 

 The duration of the conversion will depend on the size of the original 
recording, the speed of your network connection (if downloading files) and the 
speed of your system’s processor. 

 In the phase where the MRF file is being created, the original recording 
opens up in a new Elluminate Live! player window, which is typically 
minimized in your Task Bar. Do not fast forward or rewind playback during 
the conversion process. Do not close the Elluminate Live! window unless you 
want to halt the production of the multimedia file. 

Conversion progress messages 
Elluminate Publish! shows you the progress of the conversion in the Conversion Status area at 
the bottom of the window. As you can see from the progress messages, the conversion process 
goes through the following stages: 

1. Extracts and condenses audio info and creates the Audio output file. 

2. Creates the Unplugged! Recording. 

3. Creates the VCR Chat and Closed Captioning transcripts. 

4. Creates the MRF file. During this phase the original recording opens up in a new 
Elluminate Live! player. 

5. Creates the multimedia file (movie) from the MRF file.  

When the conversion is complete, you will see the word “Done” in the Conversion Status area.  

 If you cancel the conversion part way through the process, you will still 
get all the outputs created up until the point of cancellation. 

Finally, you may be prompted whether or not you would like to see the output files. This is 
controlled by the preference Reveal output files after conversion. (For details, see General 
Preferences on page 35.) 

Multimedia Output File Options 

 For recommendations on the format and resolution to choose for your 
intended output device, see Recommended Options on page 37 of the Best 
Practices appendix. 
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1. Select which tracks of the recording you would like included in your multimedia file. 

2. Select which transcripts you would like included in your multimedia file. 

 Chat (RTF) – Rich Text Format transcript of the session Chat messages. 

 Captioning (RTF) – Rich Text Format transcript of the session Closed Captioning 
messages. 

 Captioning (SRT) – Subtitle text transcript of the session Closed Captioning messages. 

3. Select the type of multimedia file output you would like to create. 

 AVI – Audio Video Interleave  

 FLV – Flash video 

 H.264 – MPEG-4 video with compression (default) 

 MOV – QuickTime video 

 MP4 – MPEG-4 video 

 WMV – Windows Media Video 

 MRF Only – Media Recording File 

4. (Optional) Select Automatic Level Control to even out the volume within your 
multimedia file. (By default, this option is on.) Within Elluminate Live! sessions, the 
volume at which a talker speaks will vary throughout the session and different talkers will 
speak at different levels from each other. Automatic Level Control will even out the 
volume levels within your multimedia file so that quiet speakers are more clearly audible. 
(Note: if a speaker is too quiet, this option may not be able to correct the level.) 

 Automatic Level Control can accentuate background noise in a recording. 
If background noise in your multimedia file is distracting, turn off this option 
and create the file again. 

5. Select the size for your multimedia file output.  

 Optimize for mobile (640 x 480) – This is a resolution of 640 x 480 pixels that is 
appropriate for creating multimedia output for mobile playback devices such as iPods. 
(default) 

 Optimize for desktop (1024 x 768) – This is a resolution of 1024 x 768 pixels that is 
appropriate for creating multimedia output to be played on your computer. 

6. (Optional) Select Scale Up Images to enlarge the images of your output file to fill the 
screen of your playback device. (By default, this option is on.) 
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 When you create a movie for the desktop, it is not unusual that the 
Whiteboard is smaller than the movie output. You may wish to turn off Scale 
Up Images in this circumstance to retain image appearance.  

Audio File Options 

 For recommendations on the format and resolution to choose for your 
intended output device, see Recommended Options on page 37 of the Best 
Practices appendix. 

1. Select the type of audio file output you would like to create. 

 MP3 (32 kbps) – MPEG-3 audio 

 MP3 (64 kbps) – MPEG-3 audio (default) 

 M4A – MPEG-4 audio 

 Ogg Vorbis – open-source format 

 WAV – uncompressed WAV files (Waveform, uncompressed audio) 

 Of the two MP3 formats, the 64K bps format produces the highest quality 
with the largest file size and the 32K bps format produces the lowest quality 
with the smallest file size.  

 The MP3 (32 kbps) format is a standard format for audio files and 
provides a balance between an MP3 recording’s quality versus its size.  

2. (Optional) Select Automatic Level Control to even out the volume within your Audio 
podcast. (By default, this option is on.) Within Elluminate Live! sessions, the volume at 
which a talker speaks will vary throughout the session and different talkers will speak 
at different levels from each other. Automatic Level Control will even out the volume 
levels within your audio podcast so that quiet speakers are more clearly audible. (Note: 
if a speaker is too quiet, this option will not be able to correct the level.) 

 Automatic Level Control can accentuate background noise in a 
recording. If background noise in your audio podcast is distracting, turn off this 
option and create the podcast again. 
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Setting Publish! Preferences 
To set preferences, select Preferences from the Edit menu (Elluminate Publish! menu on Mac) 
and then click on the desired tab. 

General Preferences 
To customize your interaction with Elluminate Publish!, set the following preferences 
under the General tab of the Preferences dialog:  

 Reveal output files after conversion – When the conversion of a recording is complete, 
you can opt to have your file browser open the directory containing your output files. To 
always display the files, select “Always”; to never display the files, select “Never”; and to 
leave the option open at the end of each conversion, select “Ask”. 

 Check for updates automatically at launch – Select this option to be automatically notified 
of any software updates when you launch Elluminate Publish! (For a discussion of how 
this option works, see Automatic Check for Updates on page 29.) 

Proxy Setting Preferences 
Publish! may be supplied links that require the use of a proxy to resolve. Typically, if your 
browser requires a proxy to make a connection, Publish! will too. One way to figure out if you 
need a proxy is to see if your browser has any proxies set. To check, look up the settings as 
follows:

 For Firefox 3, select Tools | Options | Advanced | Network | Settings.  

 For Explorer 6, select: Tools | Internet Options | Connections | LAN Settings.  

 For Safari 3, select Safari | Preferences | Advanced | Change Settings | LAN Settings.  

If proxies are required, define your proxy settings under the Proxy Settings tab of the 
Preferences dialog. The default setting is Direct Connection. If you need a proxy, select 
Manual Proxy Settings and fill in the host names and ports with the information found in your 
browser. Any proxy fields you leave empty will default to direct connections. 

 Consult your system administrator for information and assistance 
regarding proxies. 

Intellectual Property Preferences 
You can add metadata to your output files in order to identify them as your intellectual 
property. Under the Intellectual Property tab of the Preferences dialog, enter information in 
some or all of the following fields: Album, Author, Comment, Copyright, Genre and Year. 

 Note that not all movies formats will support all (or even any) of the 
intellectual property data. 



Appendix A: Best Practices 
The quality of a published recording depends on the nature of the content in the original 
recording, the output options selected during conversion and the type of device on which the 
output file will be played. We have provided a demo recording (see link below) with which you 
can experiment. This recording contains different presentation methods (Whiteboard, 
Application Sharing, etc.) at various screen resolutions with text presented in a number of 
different font sizes.  

Publish the demo file for your target output device using various combinations of output 
formats and resolutions. In this way, you can see what output format and resolution work best 
to optimally present your intended content on your intended device. You can find the demo file 
on the following web page:  

http://www.elluminate.com/support/training/next/index.jsp  

Although each situation is unique, a few general recommendations can be made with respect to 
best practices for 

 setting security controls to ensure access to recordings; 

 using the best presentation methods and font sizes in your recordings; and 

 selecting output options (format and resolution) best suited to your output device. 

Best Practices for Recording Sessions for Publication 
When recording a session for future publication into other formats, there are some things you 
can do during session recording that will ensure you get the best possible output files from 
Elluminate Publish!  

Recording for Mobile Devices 
We recommend you follow the guidelines below when recording a session for publication on a 
mobile device: 

 Use a large font size for Whiteboard presentations (28 + size in the fonts Dialog, Sans 
Serif and Serif). 

 Avoid Application Sharing. 

 Do not share your desktop. 

Recording for Computer Desktops 
Pretty much anything goes! Just keep in mind that not all Elluminate Live! session activity is 
included in all output formats. See Table 1: Output Files on page 2 for a list of which 
Elluminate Live! features are captured in the various types of output files. 
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Recommended Options 
The following Elluminate Publish! settings are recommended for producing the best possible 
output for the various player devices. 

Apple iPod, iPhone, iPod Touch or Nano 
 Resolution: use 640x480 only. 

 Format: we recommend you use H.264 only. 

Zen 
 Resolution: you may use either the 640x480 or 1024x768 resolution. The 1024x768 

resolution will automatically scale down for this device. 

 Format: we recommend any format except WMV and FLV. The Zen software is equipped 
with a media converter that will convert most formats into a useable file.15 For a list of 
supported formats on the Zen, see the Zen official website: 

http://us.creative.com/products/product.asp?category=213&subc
ategory=214&product=16999&nav=1Video

Zune 
 Resolution: See Format below. 

 Format: we recommend MP4 at either the 640x480 or 1024x768 resolution, WMV at the 
1024x768 resolution or H.264 at the 640x480 resolution. For a list of supported formats 
on the Zune, see the Zune official website: 

http://www.zune.net/en-US/mp3players/default.htm

Computer Desktops 
 Resolution: use either the 640x480 or 1024x768 resolution. 

 Format: any format at either resolution will work, although the best output can be 
achieved by selecting the H.264 format.16 

                                                 
15 Some files are not recognized though and will need a CODEC. 
16 Note: this format uses the most CPU resources. 

http://us.creative.com/products/product.asp?category=213&subcategory=214&product=16999&nav=1Video
http://us.creative.com/products/product.asp?category=213&subcategory=214&product=16999&nav=1Video
http://www.zune.net/en-US/mp3players/default.htm
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Appendix B: Help and Other Resources 

Elluminate Publish! Support Web Page  
You can access the Elluminate Publish! support web page in one of two ways:  

 From within Elluminate Publish!, select Elluminate Publish! Help from the Help menu. 

 Open your web browser and go to http://www.elluminate.com/publish/info.jsp. 

In addition to this user’s guide, the Elluminate Publish! support web page provides the 
following resources: 

 Software updates 

 Link to an Elluminate Publish! training webpage 

 Email link to Elluminate Sales to acquire license key 

Other Elluminate Resources 
 For further help using Elluminate Publish!, see our Elluminate Publish! training webpage: 

http://www.elluminate.com/support/training/next/ 

 To learn more about recordings in general, see our feature report on Recording and 
Playback available on the following page: 
http://www.elluminate.com/support/docs 

 To learn how to access a recording from within the Session Administration System, see 
our quick reference guide on Retrieving Recording Links in the SAS available on the 
following page:  
http://www.elluminate.com/support/docs/sas/asp.jsp 

 If you are having technical difficulties that your Elluminate system administrator cannot 
resolve, contact Elluminate Technical Support (see contact information on page iv). You 
may be asked for your error log file. This file can be found in your Publish subdirectory: 

Windows Default 
C:\Program Files\Elluminate\Elluminate Publish\error.log 

Mac Default 
Applications/Elluminate/Elluminate Publish/error.log 

Page 38 July 2, 2009 

http://www.elluminate.com/publish/info.jsp
http://www.elluminate.com/support/training/next/
http://www.elluminate.com/support/docs


Elluminate Publish! 
version 2.1 

 

Doc. Revision: 1.0 Page 39 

Useful Articles on the Web 
 A quick guide to video formats: 

http://gizmodo.com/5093670/giz-explains-every-video-format-you-need-to-know   

 Explanation of H.264:  
http://www.apple.com/quicktime/technologies/h264/faq.html  

3rd Party Resources for Movie and Subtitle Editing 
You can use a number of programs to create movie subtitles from your SRT captioning file. A 
good place to start your investigation of tools is on this web page: 
http://ubuntuforums.org/showthread.php?t=556267  

 Elluminate does not provide support or training materials for any 
3rd party resources. 

If you don’t have your own movie or subtitle editing tools, below are some suggested products 
for you to consider. 

Jubler 

One of the nicest subtitle editors is Jubler, which works on Linux, Windows and Mac OS X. 
You can download it from http://www.jubler.org/. To use Jubler, you must first download and 
install MPlayer, an open-source player and encoder that uses FFMPEG (and bundles it). 
MPlayer is available on the Windows, Linux and Mac OS X platforms and can be downloaded 
from http://www.mplayerhq.hu/design7/news.html. 

See this YouTube video (http://www.youtube.com/watch?v=Rl_8hk6otK8) for a demo of using 
Jubler and MPlayer to add subtitles to a video. 

MEncoder  

MEncoder is an open source program, readily available on the network (it is part of the 
MPlayer installation) you can use to merge your SRT captioning file with the multimedia file. 
MEncoder has a command-line interface, with commands that look like the following: 
$ mencoder -oac copy -ovc codec codec opts -sub sub file.srt  
-subfont-text-scale 3  

http://gizmodo.com/5093670/giz-explains-every-video-format-you-need-to-know
http://www.apple.com/quicktime/technologies/h264/faq.html
http://ubuntuforums.org/showthread.php?t=556267
http://www.jubler.org/
http://www.mplayerhq.hu/design7/news.html
http://www.youtube.com/watch?v=Rl_8hk6otK8
http://www.youtube.com/watch?v=Rl_8hk6otK8
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Subtitle Workshop 

This is another tool you can use to merge your SRT captioning file with a multimedia file. It 
will accept a variety of subtitle file formats, including our SRT file, and will convert them to 
other formats. You can download Subtitle Workshop from 
http://www.urusoft.net/products.php?cat=sw. 

 Subtitle Workshop will not merge the movie with the subtitles; you can 
use Avidemux (see below) for that. 

Avidemux Video Editor 

Avidemux is a useful open-source program available for Linux, Windows and Mac OS X that 
provides a mechanism for editing the video and producing a new video. You can download it 
from http://fixounet.free.fr/avidemux/.  
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